
 
 

 

BAB III  

PELAKSANAAN KERJA MAGANG 

3.1 Kedudukan dan Koordinasi 

Selama menjalani program magang di PT Telkomsel, penempatannya 

pada Divisi Consumer Business Growth & Analytics yang berada di bawah 

naungan langsung General Manager Consumer Business Growth & Analytics 

untuk Area Jabodetabek Jabar. Divisi ini bertanggung jawab dalam merancang 

strategi pertumbuhan pelanggan serta mengelola dan menganalisis data 

konsumen guna mendukung inisiatif bisnis Telkomsel di wilayah Jabodetabek 

dan Jawa Barat. 

Sebagai Intern Data Analyst, memiliki tugas utama dalam membantu 

pengolahan dan analisis data menggunakan berbagai tools seperti Python, Power 

BI, Tableau, dan QGIS. Data yang diolah mencakup informasi performa 

pelanggan, trafik jaringan, hingga efektivitas promosi, yang kemudian disajikan 

dalam bentuk laporan atau dashboard sebagai bahan pengambilan keputusan 

strategis. 

Posisi penempatan berada langsung di bawah bimbingan Bapak 

Aryoputro Wicaksono sebagai mentor, yang selanjutnya berkoordinasi dengan 

Manager dan melapor kepada General Manager. Alur kerja dijalankan sesuai 

dengan struktur yang sistematis, dengan komunikasi yang dilakukan secara 

berjenjang, baik melalui interaksi langsung maupun dalam pertemuan rutin 

bersama tim. 

Kolaborasi dalam tim dilakukan secara aktif melalui pembagian tugas, 

diskusi mingguan, serta review proyek. Dalam prosesnya, tidak hanya belajar 

aspek teknis pengolahan data, tetapi juga memahami pentingnya komunikasi 

yang efektif, akurasi data, dan kecepatan dalam mendukung kebutuhan bisnis. 
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Struktur organisasi Telkomsel yang jelas dan terarah membantu dalam 

memahami alur koordinasi dan tanggung jawab dalam setiap peran. Dengan 

demikian, pengalaman magang ini memberikan wawasan menyeluruh mengenai 

bagaimana proses analisis data dijalankan secara profesional dalam mendukung 

pertumbuhan bisnis di perusahaan telekomunikasi digital sebesar Telkomsel. 

Gambar 3.1 Alur Kerja Magang 

 

1. Pemberian Tugas oleh Supervisor 

 Proses kerja dimulai dari pemberian tugas oleh supervisor kepada 

mahasiswa magang. Tugas ini bisa berkaitan dengan analisis data, visualisasi, 
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pembuatan dashboard, hingga pelaporan berbasis data pelanggan atau performa 

layanan. 

2. Diskusi Detail Tugas 

 Sebelum mengerjakan tugas, dilakukan diskusi antara mahasiswa 

magang dan supervisor untuk memahami secara menyeluruh tujuan, ruang 

lingkup, data yang dibutuhkan, serta tenggat waktu penyelesaian tugas. Diskusi 

ini penting agar tidak terjadi kesalahan dalam pemahaman instruksi kerja. 

3. Pelaksanaan Pengerjaan Tugas 

 Mahasiswa magang kemudian mengerjakan tugas sesuai arahan yang 

telah diberikan. Dalam prosesnya, apabila menghadapi kendala teknis atau 

konsep, mahasiswa dapat berkonsultasi kembali dengan supervisor. 

4. Pemeriksaan Hasil oleh Supervisor 

 Setelah tugas selesai dikerjakan, hasilnya diserahkan kepada supervisor 

untuk dilakukan pengecekan. Supervisor akan memvalidasi apakah tugas telah 

dikerjakan sesuai instruksi dan standar kualitas yang ditetapkan. 

5. Evaluasi dan Saran 

a) Jika hasil tugas sesuai, maka dilanjutkan dengan diskusi bersama untuk 

membahas isi dan hasil pekerjaan, sekaligus menyampaikan umpan balik yang 

membangun. Setelah itu, mahasiswa akan diarahkan untuk mengerjakan tugas 

selanjutnya. 

b) Jika hasil tugas belum sesuai, mahasiswa akan diminta melakukan revisi 

berdasarkan arahan yang diberikan oleh supervisor. Setelah revisi dilakukan, 

hasil kerja akan diperiksa kembali hingga mencapai kualitas yang diharapkan. 
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3.2 Tugas dan Uraian Kerja Magang 

 Tabel 3.1 Timeline Pelaksanaan Kerja Magang 

No Kegiatan 
Minggu 

Ke 

Tanggal 

Mulai 

Tanggal 

Selesai 

1 Pengenalan perusahaan, struktur 

organisasi, dan alur kerja divisi 

1–2 3 Maret 

2025 

14 Maret 

2025 

2 Eksplorasi dan pemahaman 

terhadap data internal 

2–3 10 Maret 

2025 

21 Maret 

2025 

3 Melakukan data preparation 

(pembersihan, transformasi, 

integrasi dataset) 

3–14 17 Maret 

2025 

13 Juni 

2025 

4 Pengembangan visualisasi data 

menggunakan Power BI 

4–14 24 Maret 

2025 

13 Juni 

2025 

5 Pembuatan visualisasi spasial 

menggunakan QGIS 

6–13 7 April 

2025 

6 Juni 

2025 

 

3.2.1 Minggu ke-1 s/d Minggu ke-2  Pengenalan perusahaan, struktur organisasi, 

dan alur kerja divisi 

Pada awal pelaksanaan program magang, proses pengenalan terhadap 

Telkom Indonesia dijalani, khususnya pada unit Consumer Business Growth & 

Analytics untuk Area Jabodetabek Jabar sebagai lokasi penempatan. Kegiatan 

orientasi ini mencakup pengenalan struktur organisasi perusahaan, pemahaman 

terhadap visi dan misi, serta pengenalan terhadap lingkungan kerja, baik secara 

fisik maupun virtual. 
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Selain itu, pemahaman diberikan mengenai alur kerja internal tim, tugas 

dan tanggung jawab setiap bagian, serta peran strategis divisi Consumer 

Business Growth & Analytics dalam mendukung proses pengambilan keputusan 

berbasis data oleh manajemen regional. Pada fase ini, dilakukan juga pengenalan 

kepada General Manager yang membawahi divisi, serta perkenalan dengan 

supervisor langsung yang bertanggung jawab dalam proses pembimbingan 

selama masa magang. Pengenalan terhadap tools dan platform yang digunakan 

dalam pekerjaan sehari-hari turut diberikan, seperti Power BI, Python, dan 

QGIS. 
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Gambar 3.2 Logo Power BI 

Gambar 3.3 Logo Python 

Gambar 3.3 Logo QGIS 

Beberapa gambar dan data dalam laporan ini telah diburamkan (blur) 

secara sengaja untuk menjaga kerahasiaan informasi internal dan melindungi 

kepentingan perusahaan tempat magang. 
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3.2.2 Minggu ke-2 s/d Minggu ke-3  Eksplorasi dan pemahaman terhadap data 

internal 

A. Pemahaman Tentang Dataset 

Gambar 3.4 Data Evaluasi Site 

Pada tahap ini, fokus utama adalah mengolah data revenue dari file 

Area2_CP3-4_2024_Site_MV_Evaluation_202503.csv. Data ini berisi informasi 

performa revenue site Telkomsel untuk enam bulan, mulai dari Oktober 2024 

(Rev_202410) hingga Maret 2025 (Rev_202503). Proses diawali dengan 

membuka dan menampilkan data, dilanjutkan dengan tahapan data cleaning, 

transformation, lalu hasil pengolahannya akan dianalisis dan dibuatkan 

visualisasi dari datanya agar lebih mudah untuk mengambil keputusan bisnis. 

3.2.3 Minggu ke-3 s/d Minggu ke-14  Melakukan data preparation (pembersihan, 

transformasi, integrasi dataset) 

A. Load Data 

Gambar 3.5 Kode Python Load Data 
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Langkah pertama adalah mengimpor library pandas yang digunakan 

untuk manipulasi data, kemudian membaca file .csv menggunakan pd.read_csv. 

Fungsi df.head() digunakan untuk menampilkan lima baris pertama agar bisa 

memahami struktur awal dataset. 

Gambar 3.6 Menampilkan 5 Baris Pertama 

B. Cek Struktur Data 

Gambar 3.7 Kode Python untuk Mengetahui Info Dataset 

Kode ini digunakan untuk melihat struktur kolom, tipe data 

masing-masing kolom, dan jumlah non-null pada setiap kolom. Dari sini dapat 

diketahui kolom mana yang memiliki missing value dan perlu diperhatikan pada 

proses selanjutnya. 

Gambar 3.8 Hasil Cek Info Data 
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Pada gambar diatas kita bisa lihat ada 3 kolom yang tidak ada isinya dan 

tipe datanya yaitu masih float, maka pada proses selanjutnya ketiga kolom ini 

akan dihapus agar mempermudah pemrosesan data. 

C. Hapus Kolom yang Tidak Diperlukan 

Gambar 3.9 Kode Python untuk Menghapus Kolom 

Dalam file ini terdapat kolom tambahan yang tidak relevan dan muncul 

akibat kesalahan teknis, yaitu 'Unnamed: 33', 'x', dan ‘BA MV’. Kolom-kolom 

ini dihapus karena tidak menyumbang informasi penting untuk analisis. 

D. Cek Missing Values 

Gambar 3.10 Kode Python Menegecek Missing Value 

Langkah ini digunakan untuk mengetahui apakah ada nilai kosong (null) 

yang perlu ditangani lebih lanjut. Ternaya pada kolom Site ID Actual terdapat 2 

missing values, diputuskan tidak menghapus baris meskipun kolom ini kosong, 

karena yang akan jadi acuan nanti yaitu Site ID Plan. 

Gambar 3.11 Hasil Cek Missing Value 
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E. Mengecek Data Duplikat 

Gambar 3.12 Kode Python Mengecek Duplikat 

Langkah ini bertujuan memastikan tidak ada baris yang benar-benar 

sama atau Site_ID yang muncul lebih dari sekali. Hal ini penting agar analisis 

revenue dan site tidak bias akibat data ganda. 

Hasilnya adalah 0, menandakan tidak ada baris duplikat pada data yang 

digunakan. 

3.2.4 Minggu ke-3 s/d Minggu ke-14  Pengembangan visualisasi data 

menggunakan Power BI 

Memasuki minggu ketiga belas hingga keempat belas, fokus ditempatkan 

pada proses perancangan dan pengembangan dashboard interaktif menggunakan 

Power BI. Dashboard ini dibuat untuk membantu divisi Consumer Business 

Growth & Analytics Area 2 (Jabodetabek-Jabar) dalam memantau performa site 

berdasarkan metrik utama, seperti kategori payload, kategori revenue, tren 

revenue bulanan, serta distribusi program group yang berjalan. 

Gambar 3.13 Data Performa Site Setelah Diimport ke Dalam Power BI 

Langkah pertama dalam proses visualisasi data adalah mengimpor 

dataset performa site Telkomsel ke dalam Power BI menggunakan fitur Get 

23 
 

Pemanfaatan QGIS…, Safires Atalla Zaraski, Universitas Multimedia Nusantara 



 
 

 

Data. File yang digunakan berasal dari hasil pengolahan sebelumnya dalam 

format CSV, yang berisi data multi-dimensi terkait performa jaringan untuk area 

Jabodetabek Jabar (Area 2). 

Setelah proses import selesai, Power BI menampilkan data dalam bentuk 

tabel yang bisa langsung diolah dan divisualisasikan. Dataset ini terdiri dari 

sejumlah kolom penting seperti Site ID, Sitename, Kabupaten, Regional, 

Program Group, serta data numerik seperti Payload January, Payload February, 

hingga Payload April, dan juga Revenue January sampai Revenue April. Selain 

itu, terdapat pula kolom kategorikal seperti Payload Category dan Revenue 

Category yang sebelumnya telah ditentukan berdasarkan nilai rata-rata per site. 

Gambar 3.13 memperlihatkan tampilan awal data setelah berhasil dimuat 

ke dalam Power BI dan siap untuk digunakan dalam tahap analisis dan 

visualisasi. Struktur data ini menjadi dasar dalam membangun dashboard 

interaktif yang mencakup tren revenue bulanan, distribusi payload, klasifikasi 

program jaringan, dan evaluasi performa berdasarkan regional. Tahapan ini 

sangat krusial untuk memastikan bahwa semua variabel yang relevan sudah 

tersedia dan bersih sebelum divisualisasikan lebih lanjut. 

Gambar 3.14 Kolom Revenue Bulanan 
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Karena data revenue bulanan berada dalam kolom yang terpisah, perlua 

dilakukan unpivoting untuk mengubah data menjadi format long. Transformasi 

ini dilakukan melalui Power Query Editor, kolom hasil unpivot bernama 

Attribute dan Value, kemudian diubah menjadi, Month berisi nama bulan, 

Revenue berisi nilai revenue per bulan 

Gambar 3.15 Hasil Unpivot Kolom Revenue 

Power BI akan membuat dua kolom baru, yaitu Attribute yang berisi 

nama bulan (misalnya Revenue January) dan Value yang berisi nilai revenue 

masing-masing bulan 
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Gambar 3.16 Kolom Attribute dan Value Setelah di Rename 

Dilanjutkan dengan mengubah nama masing - masing kolomnya 

Attribute menjadi Month dan Value menjadi Revenue. 

Gambar 3.17 Fitur Custom Column 

Untuk memastikan urutan bulan benar (Januari hingga April), harus 

menambahkan kolom bantu yang akan dinamakan MonthOrder menggunkan 

fitur custom column. 
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Gambar 3.18 Kode untuk Mengurutkan Bulan 

Gambar di atas menunjukkan proses penambahan kolom bantu 

MonthOrder di Power Query Editor. Tujuan dari langkah ini adalah untuk 

memastikan bahwa urutan bulan dalam visualisasi line chart nantinya mengikuti 

urutan waktu yang benar (Januari → Februari → Maret → April), bukan 

berdasarkan urutan alfabet. 

Gambar 3.20 Tampilan Kolom Data Site pada Power BI 
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Pada Power BI, terdapat fitur Fields yang menampilkan daftar lengkap 

seluruh kolom dari data yang telah diimpor ke dalam workspace. Fitur ini sangat 

berguna untuk memudahkan pengguna dalam memilih kolom yang relevan, 

melakukan drag-and-drop ke dalam visual, serta memahami struktur data yang 

digunakan dalam proses visualisasi. 

Gambar 3.20 memperlihatkan tampilan struktur tabel Data_Jarvis_Site, 

yang digunakan dalam pengembangan dashboard analisis performa produk 

IndiHome di Area 2 (Jabodetabek Jabar). Tabel ini terdiri dari berbagai jenis 

kolom, baik numerik maupun kategorikal. 

Gambar 3.21 Visualisasi Donut Chart Beserta Field 

Pada visualisasi ini, menampilkan donut chart untuk menggambarkan 

distribusi persentase site berdasarkan tingkat penggunaan data bulanan. Kategori 

payload dikelompokkan ke dalam tiga tingkat, namun untuk keperluan laporan 

ini, nama kategori disamarkan serta jumlah absolut site, sehingga hanya 

menampilkan persentase sebagai acuan. Dari hasil visualisasi, terlihat bahwa 

sebagian besar site sekitar 55.55% termasuk dalam kategori dengan tingkat 

penggunaan data tertinggi, sementara 23.17% berada di kategori menengah, dan 

sisanya sebesar 21.28% berada di kategori dengan tingkat penggunaan paling 

rendah. Visualisasi ini membantu tim dalam memahami bagaimana pola 

konsumsi data tersebar di seluruh site, dan menjadi dasar awal dalam 

mempertimbangkan strategi optimasi jaringan, khususnya untuk site dengan 

tingkat penggunaan data yang tinggi secara konsisten. 
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Gambar 3.22 Visualisasi Barhart Beserta Field 

Pada visualisasi ini, digunakan bar chart untuk menampilkan distribusi 

jumlah site berdasarkan program atau promo Indihome yang diikuti, yang 

dikelompokkan ke dalam dua kategori utama: GEBUKIN dan SLAMETAN. 

Visualisasi ini menggunakan Program Group sebagai sumbu X dan jumlah siteid 

sebagai sumbu Y. Hasil dari grafik menunjukkan bahwa program GEBUKIN 

mencakup mayoritas site dengan persentase yang signifikan, yaitu sekitar tiga 

kali lipat lebih banyak dibandingkan dengan program SLAMETAN. Hal ini 

mengindikasikan bahwa dalam periode analisis, program GEBUKIN lebih 

dominan digunakan dalam pelaksanaan strategi promosi atau perluasan layanan 

Indihome di lapangan. Informasi ini dapat membantu dalam memahami pola 

adopsi program dan dapat menjadi dasar evaluasi lebih lanjut mengenai 

efektivitas masing-masing pendekatan promosi terhadap penetrasi pasar atau 

distribusi jaringan. 
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Gambar 3.23 Visualisasi Clustered Barhart Beserta Field 

Visualisasi ini menampilkan distribusi jumlah site berdasarkan wilayah 

regional, dengan masing-masing batang pada grafik mewakili sebaran site dalam 

beberapa kelompok pendapatan yang telah dikategorikan sebelumnya. Warna 

pada batang merepresentasikan kategori pendapatan tertentu, sementara tinggi 

batang menunjukkan jumlah site pada kategori tersebut di tiap wilayah. Dari 

hasil visualisasi, terlihat bahwa di semua wilayah, terdapat satu kategori 

pendapatan yang mendominasi jumlah site secara signifikan, sementara dua 

kategori lainnya memiliki sebaran yang relatif lebih rendah dan bervariasi antar 

wilayah. Pola ini menunjukkan bahwa sebagian besar site di wilayah Jabar, 

Eastern, Central, dan Western Jabotabek berada dalam kelompok pendapatan 

yang lebih tinggi, yang dapat mengindikasikan potensi kontribusi revenue yang 

kuat dari wilayah-wilayah tersebut. Visualisasi ini juga memberikan gambaran 

awal untuk mengidentifikasi area yang memiliki konsentrasi site-site dengan 

performa pendapatan rendah dan berpotensi untuk ditingkatkan. 
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Gambar 3.24 Visualisasi Line Chart Beserta Field 

Pada visualisasi ini, menggunakan line chart yang juga dilengkapi area 

shading untuk melihat perkembangan total revenue selama empat bulan terakhir. 

Melalui grafik ini, agar dapat memahami bagaimana tren pendapatan berjalan 

dari waktu ke waktu. Melalui visualisasi ini, pola tren pendapatan dari waktu ke 

waktu dapat terlihat secara umum. Meskipun nilai spesifik tidak ditampilkan, 

representasi visual ini tetap memberikan gambaran mengenai dinamika 

perubahan revenue secara keseluruhan. Visualisasi ini dapat dimanfaatkan 

sebagai dasar awal untuk dilakukan analisis lanjutan terhadap berbagai 

kemungkinan faktor yang memengaruhi performa revenue, baik dari sisi teknis, 

perilaku pelanggan, maupun efektivitas program yang dijalankan selama periode 

tersebut.. 
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Gambar 3.25 Visualisasi QnA Card 

Pada bagian ini, memanfaatkan fitur Q&A visual di Power BI yang 

memungkinkan pengguna untuk berinteraksi langsung dengan data 

menggunakan bahasa alami (natural language). Fitur ini memudahkan dalam 

eksplorasi data tanpa harus membuat visualisasi manual. Cukup dengan 

mengetikkan pertanyaan ke dalam kolom yang tersedia, sistem akan secara 

otomatis merespons dengan hasil visual yang sesuai berdasarkan pemahaman 

terhadap struktur data yang ada. 

Beberapa contoh pertanyaan yang dapat coba antara lain: "what is the 

total revenue February by revenue category" untuk melihat total pendapatan 

bulan Februari berdasarkan kategori, serta pertanyaan seperti "how many rtps are 

there" untuk menghitung jumlah entitas tertentu. Dapat juga mengajukan 

pertanyaan berbasis waktu seperti "show me total revenue March for the last 

year" dan "show me total revenue March for the last month" untuk 

membandingkan performa revenue dari bulan yang sama dalam periode yang 

berbeda. 

32 
 

Pemanfaatan QGIS…, Safires Atalla Zaraski, Universitas Multimedia Nusantara 



 
 

 

Berdasarkan pengalaman selama magang, fitur ini sangat membantu 

untuk analisis cepat dan eksploratif, terutama ketika ingin menguji hipotesis data 

atau mencari insight awal sebelum membangun visualisasi yang lebih kompleks. 

Gambar 3.26 Visualisasi Hasil QnA Menghitung RTP 

 

Salah satu pertanyaan yang telah diajukan melalui fitur Q&A Power BI 

adalah “how many rtps are there” untuk mengetahui jumlah total RTP (Regional 

Tactical Program) yang terdapat dalam dataset. Sistem secara otomatis 

merespons dengan visual yang sederhana namun informatif, yaitu menampilkan 

angka 34 yang merupakan total jumlah entri dalam kolom rtp. 

Visualisasi ini sangat membantu karena, tidak perlu membuat measure 

atau chart secara manual. Cukup dengan mengetik pertanyaan yang relevan, 

Power BI mampu mengidentifikasi maksud dari pertanyaan tersebut dan 

menghasilkan hasil hitungannya secara langsung. Fitur ini sangat berguna dalam 

proses eksplorasi awal data, terutama saat ingin melakukan pengecekan cepat 

terhadap dimensi atau agregat tertentu. 
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Gambar 3.27 Hasil Akhir Dashboard Site 

Dashboard ini dibuat sebagai alat bantu untuk memvisualisasikan 

performa site Indihome berdasarkan beberapa indikator utama, seperti kategori 

payload, program yang dijalankan, distribusi revenue berdasarkan wilayah, tren 

pendapatan bulanan, serta fitur interaktif untuk eksplorasi data menggunakan 

Q&A visual. Tujuan dari dashboard ini adalah untuk mempermudah analisis dan 

pemantauan performa secara menyeluruh, baik dari sisi penggunaan data 

maupun pendapatan. 

Pada bagian kiri atas, terdapat donut chart yang menunjukkan distribusi 

persentase site berdasarkan tingkat penggunaan data (payload). Visualisasi ini 

mengelompokkan site ke dalam tiga kategori payload, dengan satu kategori 

tampak mendominasi secara signifikan. Di sebelah kanan, terdapat bar chart 

yang menampilkan jumlah site berdasarkan dua kelompok program utama, yaitu 

GEBUKIN dan SLAMETAN, di mana program GEBUKIN terlihat jauh lebih 

banyak digunakan. 
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Kemudian, pada bagian kanan atas terdapat clustered bar chart yang 

menampilkan distribusi site berdasarkan kategori revenue di masing-masing 

region, seperti JABAR, EASTERN JABOTABEK, CENTRAL JABOTABEK, 

dan WESTERN JABOTABEK. Visualisasi ini memberi gambaran bahwa ada 

satu kategori revenue yang mendominasi di seluruh wilayah, sementara kategori 

lainnya memiliki sebaran yang lebih kecil. 

Di bagian bawah dashboard, line chart yang menggambarkan tren total 

revenue dari bulan ke bulan. Melalui grafik ini, dapat terlihat pola pergerakan 

revenue. Visualisasi tersebut memberikan insight awal yang dapat dimanfaatkan 

untuk dilakukan analisis lebih lanjut terkait berbagai faktor yang mungkin 

mempengaruhi performa pendapatan. 

Terakhir, disertakan juga fitur Q&A visual di sisi kanan dashboard. Fitur 

ini memungkinkan pengguna untuk mengajukan pertanyaan dalam bahasa alami, 

seperti "how many rtps are there" atau "what is the total revenue february by 

revenue category", yang kemudian dijawab langsung oleh Power BI dalam 

bentuk visual otomatis. Ini sangat membantu untuk eksplorasi data secara cepat 

dan intuitif, terutama saat ingin mendapatkan jawaban tanpa harus membuat 

visualisasi manual. 

 

3.2.5 Minggu ke-6 s/d Minggu ke-13  Pembuatan visualisasi spasial 

menggunakan QGIS 

Gambar 3.27 Plugin QuickMapServices 
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Gambar 3.28 Visualisasi World Map 

Pada tahap awal, membuka aplikasi QGIS dan memulai proyek baru 

dengan sistem koordinat UTM Zona 48S (EPSG:32748) untuk memastikan 

akurasi pengukuran jarak dalam satuan meter. Sebagai referensi visual, 

tambahkan layer basemap menggunakan plugin QuickMapServices, dan 

memilih Google Satellite agar lokasi titik dapat terlihat secara geografis dan 

kontekstual. Hal ini penting untuk membantu memahami distribusi spasial objek 

berdasarkan kondisi nyata di lapangan. 

Gambar 3.29 Data HWA Grid 
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Sebelum memulai proses visualisasi di QGIS, harus terlebih dahulu 

mempelajari struktur dan isi dari dua dataset utama yang digunakan dalam 

analisis spasial ini, yaitu dataset HWA Grid dan dataset Site Low Utilization. 

Dataset HWA Grid merupakan kumpulan data berbasis area yang terbagi dalam 

bentuk grid berukuran 250x250 meter. Setiap grid memuat informasi yang 

menggambarkan kondisi wilayah tersebut, seperti estimasi jumlah rumah tangga 

potensial, status ketersediaan dan pemanfaatan ODP (Optical Distribution 

Point), tingkat kompetisi pasar, serta informasi administratif seperti nama desa, 

kecamatan, kabupaten, hingga wilayah operasional (region, area, dan branch). 

Selain atribut tekstual, dataset ini juga dilengkapi dengan koordinat lintang dan 

bujur dari masing-masing grid, sehingga memungkinkan untuk divisualisasikan 

secara spasial dalam QGIS. 
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Gambar 3.30 Data Site Low Utilization 

Sementara itu, dataset Site Low Utilization berisi data titik koordinat dari 

infrastruktur jaringan eksisting yang memiliki tingkat pemanfaatan rendah. 

Masing-masing baris dalam dataset ini mewakili satu site aktif, dengan atribut 

berupa kode site, nama lokasi, serta koordinat latitude dan longitude. Dataset ini 

berperan penting sebagai acuan pengukuran spasial, khususnya untuk 

menentukan seberapa dekat suatu area grid terhadap site yang belum digunakan 

secara optimal. Kedua dataset ini kemudian digunakan secara bersamaan dalam 

QGIS untuk melakukan analisis kedekatan spasial, identifikasi wilayah dengan 

potensi pengembangan, serta visualisasi hubungan antara site dan area-area di 

sekitarnya. 
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Gambar 3.31 Mengimpor Data HWA Grid 

Langkah pertama yang perlu lakukan dalam proses visualisasi spasial 

adalah mengimpor dataset HWA Grid ke dalam QGIS. Dataset ini berisi data 

spasial berbasis area grid dengan informasi lokasi dalam bentuk koordinat Grid 

Latitude dan Grid Longitude. Untuk mengimpor data ini, digunakan fitur Add 

Delimited Text Layer, lalu menentukan Grid Longitude sebagai sumbu X dan 

Grid Latitude sebagai sumbu Y. Setelah proses import selesai, seluruh titik grid 

tampil di peta sebagai layer titik, yang kemudian digunakan sebagai dasar 

analisis potensi wilayah dan distribusi jaringan. 
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Gambar 3.32 Visualisasi Data HWA Grid 

Gambar di atas menunjukkan hasil import dataset HWA Grid ke dalam 

QGIS. Setiap titik pada peta mewakili satu area grid berukuran 250x250 meter 

yang telah dipetakan berdasarkan kolom Grid Latitude dan Grid Longitude. 

Titik-titik ini tersebar di beberapa wilayah, sesuai dengan isi atribut pada dataset. 

Setelah proses import berhasil, seluruh grid tampil dalam bentuk layer titik di 

atas basemap satelit, sehingga memudahkan untuk melakukan pengamatan 

spasial terhadap lokasi-lokasi yang belum memiliki infrastruktur ODP. Layer ini 

kemudian menjadi fokus utama dalam analisis spasial karena memuat informasi 

potensi wilayah yang belum terjangkau ODP 
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Gambar 3.33 Mengimpor Data Site Low Utilization 

Selanjutnya, mengimpor dataset Site Low Utilization, yang berisi titik 

koordinat dari infrastruktur jaringan dengan tingkat pemanfaatan rendah. Dataset 

ini juga menggunakan kolom longitude dan latitude sebagai referensi lokasi. 

Proses import dilakukan menggunakan metode yang sama seperti pada HWA 

Grid, melalui menu Add Delimited Text Layer, dan kembali menggunakan 

sistem koordinat EPSG:32748 agar konsisten dengan layer sebelumnya. Setelah 

berhasil diimpor, titik-titik site ditampilkan di peta secara visual berdampingan 

dengan titik-titik grid. Visualisasi ini memungkinkan untuk melakukan analisis 

kedekatan spasial antar grid dan site, serta menjadi dasar bagi langkah-langkah 

selanjutnya seperti buffer radius, intersect, dan perhitungan jarak antar titik. 
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Gambar 3.34 Visualisasi Data Site Low Utilization 

Gambar ini menampilkan hasil import dataset Site Low Utilization ke 

dalam QGIS. Dataset ini berisi titik koordinat dari infrastruktur jaringan 

eksisting yang memiliki tingkat pemanfaatan rendah. Setelah diimpor 

menggunakan kolom longitude dan latitude, seluruh titik site divisualisasikan 

sebagai layer terpisah dan ditampilkan bersama layer grid serta basemap. 

Titik-titik ini tersebar padat di area urban seperti wilayah Jakarta dan sekitarnya. 

Kehadiran layer ini menjadi acuan penting dalam analisis kedekatan spasial, 

karena nantinya digunakan sebagai pusat perhitungan buffer 1 km dan analisis 

jarak terhadap grid yang belum memiliki ODP aktif. 
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Gambar 3.35 Kode untuk Memfilter Baris dengan no_odp_available 

Sebelum melakukan analisis lebih lanjut, perlu memfilter data grid untuk 

hanya menyisakan baris-baris dengan nilai no_odp_available pada kolom 

Odp_utilization_layer. Filter ini dilakukan melalui fitur Select by Expression 

dengan ekspresi "Odp_utilization_layer" = 'no_odp_available'. 

 

Gambar 3.36 Membuat Buffer Dalam Radius 1 KM 

Setelah kedua dataset berhasil diimpor dan divisualisasikan di QGIS, lalu 

dilanjutkan proses analisis dengan membuat buffer sejauh 1 kilometer dari 
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titik-titik site low utilization. Buffer ini berfungsi untuk menentukan area sekitar 

site yang masih berada dalam radius jangkauan spasial tertentu, yang nantinya 

digunakan untuk mengidentifikasi grid-grid yang lokasinya cukup dekat dan 

memiliki potensi untuk dikembangkan. Untuk membuat buffer, gunakan tool 

Buffer yang tersedia di menu Vector > Geoprocessing Tools > Buffer. lalu pilih 

layer Site Low Utilization sebagai input, mengatur jarak buffer sebesar 1000 

meter, dan menyimpan hasilnya sebagai layer baru dengan nama 

Buffer_Site_1KM. Penggunaan satuan meter dimungkinkan karena seluruh layer 

telah disesuaikan ke sistem koordinat proyeksi UTM (EPSG:3857), sehingga 

hasil buffer dapat digunakan secara akurat dalam konteks pengukuran jarak. 

Gambar 3.37 Visualisasi Buffer Dalam Radius 1 KM 

Setelah proses buffer selesai, QGIS menghasilkan layer baru berupa 

lingkaran-lingkaran di sekitar titik site, yang merepresentasikan area dengan 

radius 1 kilometer dari masing-masing site low utilization. Hasil visualisasi ini 

langsung terlihat di atas basemap dan layer grid yang sebelumnya telah dimuat, 

sehingga mempermudah dalam mengamati sebaran grid yang berada di dalam 

dan di luar jangkauan tersebut. Layer buffer ini kemudian menjadi dasar untuk 

proses intersect dan disjoint, yang digunakan untuk memisahkan grid 

berdasarkan kedekatannya terhadap site. Melalui hasil buffer ini pula, secara 
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visual dapat dilihat bahwa tidak semua grid yang berstatus no_odp_available 

berada dalam cakupan spasial terhadap site eksisting, sehingga memperjelas 

potensi wilayah yang bisa diprioritaskan untuk pembangunan infrastruktur 

tambahan. 

Gambar 3.38 Memisahkan Grid Dalam Radius 1 KM 

Setelah buffer dengan radius 1 kilometer berhasil dibuat, dilanjutkan ke 

proses Extract by Location untuk mengidentifikasi grid yang berada dalam 

radius 1 km dari site low utilization. Tujuan dari langkah ini adalah untuk 

memisahkan hanya grid yang secara spasial berpotongan (intersect) dengan area 

buffer, yaitu yang berada cukup dekat dengan infrastruktur eksisting. Buka menu 

Vector > Geoprocessing Tools > Extract by Location, lalu memilih layer HWA 

Grid sebagai input, dan Buffered Site sebagai layer acuan. Pada bagian spatial 

predicate, pilih opsi intersects, yang berarti hanya grid yang bersentuhan atau 

berada di dalam area buffer yang akan diekstrak. Hasil ekstraksi disimpan ke 

dalam layer baru dengan nama Grid_Dalam_1KM, yang nantinya dianalisis 

lebih lanjut 
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Gambar 3.39 Visualisasi Grid Dalam Radius 1 KM 

Hasil dari proses Extract by Location menghasilkan layer baru yang 

berisi grid-grid yang berada di dalam atau bersentuhan langsung dengan area 

buffer 1 km dari site low utilization. Secara visual, grid dalam layer ini tampak 

menumpuk atau berada di dalam lingkaran buffer yang telah dibuat sebelumnya. 

Layer ini menjadi penting karena mewakili wilayah-wilayah yang berada cukup 

dekat dengan site eksisting namun masih belum memiliki ODP aktif 

(berdasarkan filter sebelumnya). Dengan kata lain, hasil ini mengindikasikan 

area yang secara spasial berpotensi untuk dihubungkan ke infrastruktur yang 

sudah ada, baik melalui pengembangan jaringan baru maupun optimalisasi site 

low utilization. Layer inilah yang kemudian dianalisis lebih lanjut untuk 

mengetahui jarak sebenarnya terhadap site terdekat. 
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Gambar 3.40 Memisahkan Grid diluar Radius 1 KM 

Setelah mengekstrak grid yang berada di dalam radius 1 kilometer dari 

site low utilization, dilanjutkan proses analisis dengan mengidentifikasi grid 

yang justru berada di luar jangkauan tersebut, yaitu grid yang tidak berpotongan 

sama sekali dengan buffer 1 km. Untuk keperluan ini, kembali menggunakan 

fitur Extract by Location, namun kali ini memilih opsi disjoint sebagai predicate 

spasial. Dengan predicate ini, sistem akan menyeleksi grid yang tidak memiliki 

hubungan spasial apapun (tidak menyentuh atau berada di dalam) dengan area 

buffer. Input layer yang digunakan tetap HWA Grid, sedangkan layer 

pembandingnya adalah Buffer Site. Hasil ekstraksi ini kemudian disimpan dalam 

layer baru dengan nama Grid > 1KM, yang berisi grid-grid yang secara geografis 

tidak berada dalam jangkauan langsung dari site eksisting. 
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Gambar 3.41 Visualisasi Grid diluar Radius 1 KM 

Hasil dari proses extract dengan predicate disjoint menghasilkan layer 

Grid_Luar_1KM, yang berisi grid-grid yang berada lebih dari 1 kilometer dari 

titik site low utilization. Secara visual, grid-grid ini tampak berada di luar 

lingkaran buffer 1 km yang sebelumnya dibuat, tersebar di area yang belum 

terjangkau oleh infrastruktur eksisting. Layer ini penting karena mewakili 

wilayah dengan potensi perluasan jaringan jangka menengah atau panjang, di 

mana tidak ada site terdekat dalam radius 1 km dan kemungkinan besar 

membutuhkan pembangunan infrastruktur baru. Data ini menjadi dasar bagi 

pengambilan keputusan strategis dalam hal perluasan coverage serta 

pengembangan ODP di wilayah-wilayah baru yang saat ini masih belum 

tersentuh. 
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Gambar 3.42 Menghitung Jarak Grid Dalam Radius 1 KM ke Site 

Setelah berhasil memisahkan grid-grid yang berada dalam radius 1 km 

dari site low utilization, proses dilanjutkan dengan menghitung jarak aktual dari 

setiap grid tersebut ke site terdekat menggunakan tool Distance to Nearest Hub 

(Line to Hub). Tool ini dapat diakses melalui menu Vector > Analysis Tools > 

Distance to Nearest Hub (Line to Hub). Pada tahap ini, pilih layer Extracted 

<1km sebagai input point layer dan layer Site Low Utilization sebagai hub layer. 

Tool ini secara otomatis mencari titik site terdekat dari setiap grid, lalu 

menggambarkan garis koneksi antara keduanya dan menghitung jaraknya secara 

presisi berdasarkan koordinat UTM. Hasil analisis disimpan sebagai layer baru 

berupa garis-garis antar titik, yang juga menyertakan informasi jarak dalam 

kolom atribut bernama HubDist. 
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Gambar 3.43 Visualisasi Garis Grid Dalam Radius 1 KM ke Site 

Gambar di atas menunjukkan hasil visualisasi dari proses Distance to 

Nearest Hub, khusus untuk grid-grid yang berada dalam radius 1 km dari site 

low utilization. Setiap garis pada peta mewakili jalur terpendek antara satu titik 

grid ke site terdekatnya. Visualisasi ini memberikan gambaran spasial yang jelas 

mengenai hubungan langsung antara lokasi potensial (grid) dan infrastruktur 

eksisting (site). Dengan adanya garis koneksi ini, dapat diidentifikasi seberapa 

dekat masing-masing grid terhadap site yang masih belum dimanfaatkan secara 

optimal. Selain tampilan visual, layer hasil ini juga menyimpan data kuantitatif 

berupa panjang garis (dalam meter), yang nantinya digunakan untuk analisis 

lebih lanjut 
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Gambar 3.44 Menghitung Jarak Grid diluar Radius 1 KM ke Site 

Setelah sebelumnya memisahkan grid yang berada di luar radius 1 

kilometer dari site low utilization menggunakan metode disjoint, analisis 

dilanjutkan dengan menghitung jarak aktual dari grid tersebut ke site terdekat 

menggunakan tool Distance to Nearest Hub (Line to Hub). Tool ini dapat diakses 

melalui menu Vector > Analysis Tools > Distance to Nearest Hub (Line to Hub). 

Dalam konfigurasi ini, pilih layer Grid > 1km sebagai input point layer, 

sedangkan layer Site Low Utilization digunakan sebagai hub layer. Tool ini 

secara otomatis mengidentifikasi site terdekat dari masing-masing grid, 

menggambar garis penghubung antar titik, dan menghitung jaraknya dalam 

satuan meter (karena semua layer telah menggunakan sistem koordinat proyeksi 

EPSG:3857). 
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Gambar 3.45 Visualisasi Garis Grid diluar Radius 1 KM ke Site 

Gambar di atas menampilkan hasil visualisasi dari proses Distance to 

Nearest Hub untuk grid-grid yang berada di luar jangkauan 1 km dari site low 

utilization. Pada peta, setiap garis menunjukkan koneksi antara titik grid dengan 

site terdekatnya, meskipun secara spasial letaknya lebih jauh dibandingkan grid 

dalam radius 1 km. Visualisasi ini memperlihatkan bahwa beberapa wilayah grid 

memang secara geografis cukup terpencil dari infrastruktur eksisting, sehingga 

kemungkinan memerlukan pembangunan jaringan baru jika ingin dijangkau. 

Garis-garis penghubung ini tidak hanya membantu dalam memahami hubungan 

spasial antar titik, tetapi juga menyimpan nilai jarak aktual yang dapat dianalisis 

lebih lanjut 

. 
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Gambar 3.46 Mengekspor Jarak Grid ke Site ke Dalam File CSV 

Setelah proses perhitungan jarak antara grid dan site menggunakan tool 

Distance to Nearest Hub selesai, dilanjutkan dengan mengekspor hasil analisis 

tersebut ke dalam format CSV untuk keperluan dokumentasi dan analisis 

lanjutan di luar QGIS. Proses ekspor dilakukan dengan membuka attribute table 

dari layer hasil Line to Hub, kemudian memilih opsi Export > Save Features As. 

Pada dialog ekspor, pilih format output sebagai Comma Separated Value (CSV), 

menentukan nama file dan direktori penyimpanan. Ekspor data ke dalam format 

CSV ini memungkinkan untuk mengakses dan mengolah data jarak secara lebih 

fleksibel menggunakan software lain seperti Microsoft Excel atau Power BI. 
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Gambar 3.46 Hasil Ekspor Jarak Grid ke Site ke Dalam File CSV 

File CSV yang dihasilkan berisi data atribut dari layer garis koneksi 

antara grid dan site terdekat. Setiap baris dalam file mewakili satu hubungan 

antara titik grid dan satu titik site, lengkap dengan informasi spasial dan 

numerik. Salah satu kolom terpenting dalam file ini adalah HubDist, yaitu nilai 

jarak aktual dalam meter dari masing-masing grid ke site terdekatnya. Selain itu, 

file ini juga mencakup kolom identifikasi seperti ID grid (Grid_250), serta 

koordinat geografis (latitude dan longitude) dari masing-masing titik. Data ini 

berguna untuk analisis kuantitatif lanjutan, seperti pengelompokan grid 

berdasarkan jarak, pemetaan prioritas pengembangan infrastruktur. 

 

3.3 Kendala yang Ditemukan 

Tabel 3.2 Kendala Yang Ditemukan 

No Tahapan Kendala 

1 Pengenalan lingkungan 
kerja dan sistem analisis 

Proses adaptasi terhadap alur kerja divisi 
dan pemahaman awal mengenai sistem 
pelaporan serta terminologi internal 
memerlukan waktu yang cukup lama. 

2 
Pemahaman awal terhadap 
struktur data dan tujuan 
analisis 

Beberapa field dalam dataset memiliki 
nama yang kurang deskriptif dan tidak 
tersedia dokumentasi awal, sehingga 
memerlukan waktu untuk memahami 
konteksnya. 
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3 Pengolahan data 
menggunakan Python 

Ditemukan beberapa file data dengan 
format yang tidak konsisten antar bulan, 
serta kolom-kolom yang memerlukan 
cleaning sebelum bisa dianalisis. 

4 Visualisasi performa bisnis 
di Power BI 

Kesulitan dalam menentukan jenis 
visualisasi yang tepat untuk 
menyampaikan insight yang kompleks 
namun tetap ringkas dan intuitif. 

5 Import dan pengolahan 
data spasial di QGIS 

Koordinat dalam dataset perlu dikonversi 
terlebih dahulu dan penyamaan sistem 
proyeksi (CRS) penting agar hasil buffer 
dan jarak akurat. 

6 
Analisis spasial 
menggunakan Buffer, 
Intersect, dan Line to Hub 

Urutan proses yang salah atau kurang teliti 
menyebabkan tool seperti Line to Hub 
tidak menghasilkan output yang 
diharapkan. 

 

3.4 Solusi atas Kendala yang Ditemukan 

Tabel 3.3 Solusi Atas Kendala Yang Ditemukan 

No Tahapan Solusi 

1 Pengenalan lingkungan 
kerja dan sistem analisis 

Melakukan diskusi langsung dengan 
supervisor dan rekan tim untuk memahami 
struktur kerja, serta membaca dokumentasi 
internal perusahaan secara bertahap. 

2 
Pemahaman awal terhadap 
struktur data dan tujuan 
analisis 

Berdiskusi langsung dengan pembimbing 
magang dan rekan kerja terkait struktur 
data, serta melakukan eksplorasi data 
mandiri dengan Python untuk memahami 
pola isinya. 

3 Pengolahan data 
menggunakan Python 

Dilakukan proses data cleaning 
menyeluruh menggunakan Python 
(pandas), serta menyusun template 
transformasi untuk menyatukan struktur 
data yang tidak seragam. 

4 Visualisasi performa bisnis 
di Power BI 

Melakukan uji coba beberapa tipe visual 
dan meminta feedback dari pembimbing 
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untuk memilih visualisasi yang paling 
efektif, serta menggunakan bookmark 
interaktif. 

5 Import dan pengolahan 
data spasial di QGIS 

Menyesuaikan sistem koordinat semua 
layer ke CRS EPSG:3857 sebelum analisis 
spasial dimulai, serta mengecek ulang 
format kolom koordinat sebelum import. 

6 
Analisis spasial 
menggunakan Buffer, 
Intersect, dan Line to Hub 

Menyusun workflow spasial yang 
sistematis: mulai dari filter → buffer → 
extract location → hitung jarak, serta 
verifikasi visual di setiap tahap. 
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